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1/1

1. short-term

2. permanent

3. flash

4. smart

1/1

1. CD-W

2. CD-RAM

3. CD-DVD

4. CD-RW
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Total points 52/52

STUDENT NAME *

1.Random Access Memory (RAM) is a _______ type of memory.
रैंडम एक्सेक्स मेमोरी (RAM) एक _______ प्रकार की मेमोरी है।

*

2.Three types of compact disks include CD, CD-R and ______.
CD, CD-R और _____ ये कॉम्पै क्ट क्ट डि स्क के  तीन प्र कार हैं ।

*



1/1

1. Sticky pad

2. Adobe Reader

3. Sticky notes

4. Sketchbook

1/1

1. Arrow Right

2. Shift + Arrow Right

3. Ctrl + Shift + Arrow Right

4. Ctrl + Arrow Right

1/1

1. MINV function

2. MINVERSE function

3. INVM function

4. INVERSEM function

3.Which of the following app the best way to write quick notes on your
Windows 10 desktop by signing up with Microsoft account?
निम्नलिखित में से कौन सा ऐप Microsoft खाते के  साथ साइन अप करके  आपके  विं
डोज 10 डेस्क टॉप पर त्व त्व रि त नोट्स लि खने का सबसे अच्छा तरीका है?

*

4.Which of the following keyboard shortcut is used for selecting to the
right word by word in Open Office Writer?
ओपन ऑफि स राइटर में शब्द ब्द दर शब्द ब्द दाईं ओर चयन करने के  लि ए नि म्न लि
खि त में से कि स की बोर्ड र्ड शॉर्ट र्टकट का उपयोग कि या जाता है?

*

5.Which function returns the matrix inverse of an array in MS-Excel 2019?
MS-Excel 2019 में , कौन-सा फं क्श न ऐरे  का प्र ति लोम मैट्रि  क्स क्स देता है?

*
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1. Track ball

2. Joystick

3. Touch surface

4. Touch screen

1/1

1. Mass memory

2. RAM

3. ROM

4. PROM

1/1

1. C

2. Python

3. Assembly

4. BASIC

6._______ is generally used to play fast computer games
_______ का उपयोग आमतौर पर तेज़ कं प्यू टर गेम खेलने के  लि ए कि या जाता है।

*

7._______ is used for storing programs and data currently being
processed by the CPU
वर्त मान में सीपीयू (CPU) द्वा रा संसाधि त प्रो ग्रा मों और डेटा को संग्र हीत करने के  लि ए
कौन-सी कं प्यू टर मेमोरी का उपयोग कि या जाता है?

*

8.Which of the following programming language is used in general for
Artificial intelligence based problems?
आर्टि फि शि यल इंटेलि जें स आधारि त समस्या ओं के  लि ए नि म्न लि खि त में से कौन सी
प्रो ग्रा मिं ग भाषा का सामान्य न्य रू प से उपयोग कि या जाता हैै ?

*



1/1

1. Number, Text and Logical

2. Data, Words and Object

3. Data, Numbers and Labels

4. Equation, Data and Object

1/1

1. XML paper specification

2. Microsoft Word

3. Notepad

4. Microsoft Excel

1/1

1. The Memory unit can be categorized in two ways namely, primary memory and
secondary memory

2. Secondary storage is the fastest memory than primary memory that operates
at electronic speeds

3. The most common examples of primary memory are RAM and ROM

4. Secondary memory is used when a large amount of data and programs have to
be stored for a long-term basis

9.There are three types of data found in a spreadsheet:
स्प्रेडशीट में नि म्न में से कौन-से तीन प्र कार के  डेटा पाए जाते हैं ?

*

10.Which of the following has the .xps file extension?
निम्न में से कि सका फ़ा इल एक्स क्स टें टेंशन .xps होता है?

*

11.Which of the following is false with reference to memory unit of a
computer system?
कं प्यू टर सि स्ट म की मेमोरी यूनि ट के  संदर्भ में नि म्न लि खि त में से कौन सा गलत है?

*



1/1

1. Phishing

2. Data Privacy

3. Software piracy

4. Spamming

1/1

1. CCD

2. Laser

3. Device-Driver scanner

4. Pen-type

1/1

1. Thou shall not use a computer to steal.

2. Thou shall snoop through other people's computer files.

3. Thou shall not use a computer to bear false witness.

4. Thou shall not appropriate other people's intellectual output

12.________ defines the rights of individual users or organisations to keep
their personal data and information secret
________, व्य क्ति गत उपयोगकर्ता ओं या संगठनों के  अपने व्य क्ति गत डेटा और सूचना
को गुप्त रखने के  अधि कारों को परि भाषि त करता

*

13.Which of the following does NOT represent a barcode reader type?
निम्नलिखित में से कौन सा बारकोड रीडर का एक प्र कार नहीं  है?

*

14.Which of the following is NOT a rule listed in the ten commandments
of computer ethics as defined by the Computer Ethics Institute?
कं प्यू टर नैति कता संस्था न द्वा रा परि भाषि त कं प्यू टर नैति कता की दस कं मांडमें ट्स
में नि म्न लि खि त में से कौन-सा नि यम सूचीबद्ध नहीं  है?

*
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1. Input unit

2. Output unit

3. ALU

4. Memory unit

1/1

1. LAN

2. PAN

3. MAN

4. WAN

1/1

1. 60

2. 48

3. 64

4. 84

15.The primary function of which unit is to send the processed results to
the user?
किस यूनि ट का प्रा थमि क कार्य उपयोगकर्ता को संसाधि त परि णाम भेजना है?

*

16.______ is a network located entirely on one site such as an office,
school or within a group of buildings that are in close area, that are
connected together.
____________ एक नेटवर्क  र्क  है, जो पूरी तरह से एक ही साइट जैसे; कार्या लय, स्कू  स्कू
ल या आपस में जुड़ी हु ई नि कटवर्ती इमारतों के  समूह पर स्थि त होता है।

*

17.What is the Decimal Equivalent of the given Octal Number (60)8 ?
दीगई अष्ट क संख्या ख्या (60)8 का दशमलव समतुल्य ल्य क्या क्या है?

*
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1. Mark Zuckerberg

2. Tim Berners-Lee

3. Charles Babbage

4. Paul Buchheit

1/1

1. corrected copy

2. cancelled copy

3. curation copy

4. carbon copy

1/1

1. .exe and .com

2. .doc and .xls

3. .ppt and .pxs

4. .y2k and .wmk

18.Who among the following is famously associated with the Facebook
as a founder?
निम्नलिखित में से कौन फे सबुक के  संस्था पक के  रू प में प्र सि द्ध है?

*

19.The full form of CC in an email is _________.
ई-मेल में CC का पूर्ण रू प क्या क्या होता है?

*

20.A file-infecting virus infects files with _______ extensions.
एक फाइल-संक्र मि त वायरस _______ एक्स क्स टें टेंशन वाली फाइलों को संक्र मि त
करता है।

*



1/1

1. MPEG-1

2. MPEG-2

3. MPEG-4

4. MPEG-12

1/1

1. maintained

2. reduced

3. increased

4. ignored

1/1

1. File Type Monitoring

2. File Hash Monitoring

3. File Integrity Monitoring

4. File Authenticity Monitoring

21.Which of the following is NOT the MPEG compression technique?
म्नमें से कौन सी एक MPEG संपीडन तकनीक नहीं  है?

*

22.In the output gain of audio compression controls, if the audio signal
has been compressed, the overall level of the signal will be _______.
ऑडि यो संपीडन नि यंत्र ण के  आउटपुट गेन में , यदि ऑडि यो सि ग्न ल को संपीडि त कि
या जाता है, तो सि ग्न ल के  समग्र स्त र पर क्या क्या प्र भाव पड़े ड़ेगा?

*

23.The ______ helps the user to detect any changes made to the original
file.
______ उपयोगकर्ता को मूल फ़ा इल (Original File) में कि ए गए कि सी भी बदलाव का
पता लगाने में मदद करता है।

*



1/1

1. Danish Boot

2. Elk Cloner

3. Melissa.A

4. Mr. Klunky

1/1

1. F8

2. F7

3. F4

4. F1

1/1

1. Secure Socket Layer

2. Secure Standard Layer

3. Secure Socket Location

4. Safe Socket Layer

24.The first computer virus was called _______, which was written by
Richard Skrenta
___________ नामक पहला कं प्यू टर वायरस रि चर्ड र्ड स्क्रे  स्क्रे  न्टन्ट (Richard
Skrenta) द्वा रा लि खा गया था।

*

25.The Advanced Boot Options screen can be started by pressing the
____ key before Windows starts
विंडोज़ के  चालू होने से पहले ____ की को दबाकर एडवांस्ड बूट ऑप्शं स स्क्री न खोली
जा सकती है।

*

26.What is the full form of SSL?
SSL का पूर्ण रू प क्या क्या है?

*



1/1

1. Polyboot.B

2. Boot Sector

3. Multipartite

4. Macro

1/1

1. signature

2. subject

3. formatting options

4. attachments

1/1

1. Encapsulated PostScript

2. Audio File

3. Programming/Scripting file

4. Hypertext file

27.The _______________ virus can affect both the boot sector and the
program files at the same time.
___________ वायरस एक ही समय में बूट सेक्ट क्ट र और प्रो ग्राम फाइल दोनों को प्र
भावि त कर सकता है।

*

28.You can choose to create a ______ that will appear at the end of every
email we send, either as a contact information or a favorite quote.
आप एक ______ बनाना चुन सकते हैं जो हमारे  द्वा रा भेजे जाने वाले प्र त्ये त्ये क ईमेल के
अंत में , संपर्क  र्क  जानकारी या पसंदी दा उद्ध रण के  रू प में दि खाई देगा।

*

29.EPS file format represents which of the below file?
EPS फाइल फॉर्मेट, निम्नलिखित में से किस फाइल को व्य क्त करता है?

*
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1. automation

2. mechanical

3. manual

4. automatic

1/1

1. Jack Dorsey

2. Andrew McCollum

3. Jimmy Wales

4. Steven Levy

1/1

1. Social networks

2. Search engine

3. Routers

4. Protocols

30.Testing any software or an application according to the client's needs
without using any automation tool is known as ________ testing.
करना ________ परीक्ष ण (Testing) के  रूप में जाना जाता है।

*

31.Who among the following is the co-founder of Twitter?
निम्नलखित में से कौन ट्वि ट्विट्वि टर के  सह संस्था पक है?

*

32.Which of the following is used to search other websites by typing a
keyword?
निम्नलिखित में से कि सका उपयोग की वर्ड र्ड टाइप करके  अन्यन्य वेबसाइटों को खोजने
के  लिए किया जाता है?

*
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1. Web services

2. Telnet

3. FTP

4. Gopher

1/1

1. Authenticate all bank transactions

2. Encrypt all bank transactions

3. Decrypt all bank transactions

4. Scan all bank transactions

1/1

1. Ctrl + F + >

2. Ctrl + Shift + <

3. Ctrl + >

4. Ctrl + F + <

33.Which of the following is a communication service on Internet?
निम्नलिखित में से कौन सी इंटरनेट पर संचार सेवा है?

*

34.What is the use of a UPI PIN in BHIM?
भीम (BHIM) में यू.पी.आई (UPI) पि न की क्या क्या उपयोगि ता है?

*

35.What is the keyboard shortcut to decrease font size in Microsoft Word
2010?
माइक्रो सॉफ्ट फ्ट Word 2010 में फ़ॉ न्ट न्ट के  आकार को कम करने के  लि ए उपयोग
कि या जाने वाला की बोर्ड र्ड शॉर्ट र्टकट क्या क्या है?

*
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1. It is a type of protocol

2. It is a type of file extension

3. It is a type of computer language

4. It is a font standard used in Microsoft and Apple OS

1/1

1. Nine

2. Seven

3. Eight

4. Ten

1/1

1. Capitalize names of days

2. Capitalize last letter of table cells

3. Capitalize last letter of sentences

4. Correct THree INitial CApitals

36.What Does TrueType Font mean?
ट्रू  टाइप फ़ॉन्ट न्टका क्या क्या अर्थ है?

*

37.How many levels of indented text can appear in a multilevel list in an
MS-Word 2010 document?
एक MS-Word 2010 डॉक्यु क्यु में ट में एक बहु स्त रीय सूची में इंडें डेंट कि ए गए
टेक्स्ट के  कि तने स्त र दि खाई दे  सकते हैं ?

*

38.Which of the following statements in Microsoft Word is correct?
MS-Word में नि म्न लि खि त में से कौन-सा कथन सही है?

*



1/1

1. Set as Default

2. Apply

3. Ok

4. Tabs

1/1

1. Reviewing Pane Above

2. Reviewing Pane Below

3. Reviewing Pane Horizontal

4. Reviewing Pane Vertical

39.While working with line and paragraph spacing in the Paragraph group,
you can use Microsoft Word document's ______ feature to save all of the
formatting changes you made and automatically apply them to new
documents.
पैराग्रा फ ग्रु ग्रुप में लाइन और पैराग्रा फ स्पे सिं ग के  साथ काम करते समय, आप माइक्रो
सॉफ्ट फ्ट Word डॉक्यु क्यु में ट के  ______ फी चर का उपयोग अपने द्वा रा कि ए गए
सभी फॉर्मे टिं ग परि वर्त नों को सेव करने के  लि ए कर सकते हैं और स्व चालि त रू प से
उन्हें न्हें नए डॉक्यु क्यु में ट पर लागू कर सकते हैं ।

*

40.Select _____________ to see a list of all changes next to your document
while tracking changes in the MS-Word 2019.
MS-Word 2019 में परि वर्त नों को ट्रै  ट्रै क करते समय अपने दस्ता वेज़ के  आगे सभी
परि वर्त नों की सूची देखने के  लि ए _____________ चुनें ।

*
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1. Final Showing Markup

2. Final

3. Original

4. Original Showing Markup

1/1

1. &

2. @

3. ©

4. #

41.______ view in Microsoft Word 2019 displays the original document
without tracked changes and comments showing. However, any tracked
changes or comments in the document that have not been accepted,
rejected or deleted remain in the document.
माइक्रो सॉफ्ट फ्ट वर्ड र्ड 2019 में ______ व्यू , ट्रै  ट्रै क कि ए गए परि वर्त नों (चें ज) और
टि प्प णि यों (कमें ट्स) को दि खाए बि ना मूल डॉक्यु क्यु में ट प्र दर्शि त करता है।
हालाँकि , डॉक्यू क्यू में ट में कि या गया कोई भी ट्रै  ट्रै क परि वर्त न (चें ज) या टि प्प णि याँ
(कमें ट्स) जि न्हें न्हें स्वी कार, अस्वी कार या हटाया (डि लीट कि या) नहीं  गया है, वह
डॉक्यु क्यु में ट में बनी रहती हैं ।

*

42.   Display Question Number : Yes
कॉपीराइट को दर्शा ने के  लिए _____ चिह्न का उपयोग कि या जाता है।

*
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1. URL modification

2. URL support

3. URL balancing

4. URL normalisation

1/1

1. Fill handle

2. Pivot table

3. Pointer

4. Ribbon

43. The process by which URLs are modified and standardised in a
consistent manner is called:
उसप्र क्रिया को क्या क्या कहते हैं जि सके  तहत URL को सतत रूप से संशोधि त और
मानकी कृ त किया जाता है?

*

44.To use the ______ in Microsoft Excel, bring the mouse pointer at the
bottom right corner of the cell. It will change into a + sign. Left-click on it
and drag it downwards to the required range of cells.
माइक्रो सॉफ्ट फ्ट Excel में , ______ का उपयोग करने के  लि ए माउस कर्स र को सेल के
नि चले दाएं  कोने में लाएं । यह एक + चि ह्न में बदल जाएगा। उस पर लेफ्ट फ्ट -क्लि क्लि
क्लि क करें  और इसे नीचे की ओर खीं  चकर आवश्य क सेल्स की रें  ज में ले जाएँ ।

*
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1. =AGE(B2, TODAY(),”Y”)

2. =DATE(B2, TODAY(),”Y”)

3. =DATE(TODAY(),B2,”Y”)

4. =DATEDIF(B2, TODAY(),”Y”)

1/1

1. Data -> Data Tools group -> Text to Columns

2. Formulas -> Defined Names group -> Define Name

3. Home -> Cells group -> Format

4. View -> Show group -> Headings

45.In Microsoft Excel 2019, if cell B2 contains the date of birth of a
person, his/her age can be computed by ______.
माइक्रो सॉफ्ट फ्ट Excel 2019 में , यदि सेल B2 में कि सी व्य क्ति की जन्म ति थि है, तो
उसकी आयु की गणना ______ द्वा रा की जा सकती है।

*

46.Identify the correct sequence of steps for naming a range of cells in
Microsoft Excel 2019.
MS-Excel 2019 में सेल्स की रें  ज के  नामकरण के  लि ए चरणों के  सही क्र म की
पहचान करें  ।

*
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1. .xls

2. .xlsm

3. .xlss

4. .xlsx

1/1

1. closes the Developer tab

2. executes a macro

3. opens Help Menu for macros

4. opens the Microsoft Visual Basic For Applications Editor

1/1

1. Ctrl + L

2. Alt + T

3. Ctrl + Shift + T

4. Ctrl + Alt + L

47.An MS-Excel macro-enabled workbook has the filename extension
______.
MS-Excel मैक्रो -इनेबल्ड ल्ड वर्क  र्क  बुक में फ़ा इल नेम एक्स क्स टें टेंशन ______ होता
है।

*

48.The keyboard shortcut Alt + F11 ______ in Microsoft Excel 2019.
MS-Excel 2019 में की बोर्ड र्ड शॉर्ट र्टकट Alt + F11 ______।

*

49.Which of the following keyboard shortcut in MS-Excel 2019 display the
Create Table dialog box?
MS-Excel 2019 में नि म्न लि खि त में से कौन सा की बोर्ड र्ड शॉर्ट र्टकट क्रि एट टेबल
डायलॉग बॉक्स क्स प्र दर्शि त करता है?

*
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1. bar

2. gridline

3. legend

4. trendline

1/1

1. 10

2. 50

3. 100

4. 127

50.By using regression analysis, you can extend a ______ in a chart
beyond the actual data to predict the future values in Microsoft Excel
2019.
प्रतिगमन विश्लेषण (रिग्रेशन एनालि सि स) का उपयोग करके , आप MS-Excel 2019 में
भविष्यष्य के  मूल्यों ल्यों (फ्यू फ्यू चर वैल्यू ल्यूज़) की भवि ष्य ष्य वाणी करने के  लिए एक
चार्ट र्ट में वास्त वि क डेटा से परे  ______ का वि स्ता र कर सकते हैं ।

*

51.In Microsoft Office, how many levels of Undo operations can be done
in a sequence?
MS Office में एक क्र म में परेशंस को कि तने स्तरों तक कि या जा सकता है?

*
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52.A background image can be added to an MS-Excel spreadsheet using
the ______ tab.
बैकग्रा उंड इमेज को ______ टैब का उपयोग करके  MS-Excel स्प्रे डशीट में जोड़ा (ऐड
कि या) जा सकता है।

*
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